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TO INSTALL CLOUDINGO STUDIO

1. Download the Cloudingo Studio installer and click the Run button to begin the initial installation process.

Do you want to run this file?

Name: C:\setup.exe

Publisher: Symphonic Source, Inc.
Type: Application
From: Ci\setup.exe

[¥] Always ask before opening this file

While files from the Intemet can be useful, this file type can
potentially harm your computer. Only run software from publishers

From (Hover over the string below to see the full domain):

studio.cloudingo.com
< | ool | ) ontinstal |

While applications from the Internet can be useful, they can potentially harm your computer, If
More Information ..

Publisher:
Symphonic Source, Inc,

you do not trust the source, do not install this software.

3. The installation process may take a few minutes to complete.

This may take several minutes. You can use your computer to do other tasks
during the installation.

@ Name: CloudingoStudio

From:  studio.cloudingo.com

——————8
Downloading: 209 MB of 37.1 MB
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REGISTERING CLOUDINGO STUDIO

After the installation has completed you will need to register Cloudingo Studio to get a license. A registration
menu will appear after installation. (If it does not appear, try pressing Alt-Tab on your keyboard to see it, or
minimize windows until you see it).

1. Enter your registration details, select | Agree, and click Register. After registering you will receive an email with
anew license key.

2. Enter your license key in the designated cell.

3. Accept to the license agreement, and click Validate License.

|

Cloudingo Studio Registration

Get your FREE license key by filling in the form below.

This is how the Cloudingo team manages support/enhancement requests.

First Name:
e, Last Name:
License Key: | 1LKS7SBWVXT! Oli)\falidate License
Email Address:
B 1 agree to end user license agreement
Company:
[C] 1agree to end user license agreement

Register
Cancel

4. You are now ready to connect to Salesforce.

Product Documentation 2



CONNECT TO SALESFORCE (BASIC USE)

1. Launch Cloudingo Studio
2. Open the File menu and select Connect to Salesforce as shown below:

File| Edit View Options}
Connect to Salesforce

e
X¥  Disconnect from Salesforce

New

B o
H

"EE EE
H

3. Enter your Salesforce credentials in the popup dialogue box.
4. (Click Connect and start using Cloudingo Studio for your Force.com development!

File Edit View Options Window Help
PN B NewQuey @M O A X%
i Active ~ SOQL+ - p=1 ]

I.‘.I
L
|

B Object Explorer i

N
A
cloudingo i
Connection Type  Production v

Username/Email ~ johnsmith@johnsmith.com v

Password trrrreeses

Security Token  321kjf02mIma%082nlis9023nj{
Save Details?

Product Documentation



FEATURES (BASIC USE)
QUERY BUILDER

By clicking on one of the Orgs, Cloudingo Studio will automatically create a new query based on selected fields.
Uncheck or check different fields to alter the query on-the-fly:

File Edit View Options Window Help
WX PNewQuey @H BAX
: Active ryanhoward@95demo.com ~ SOQL+ R R -

k3 Object Explorer » 0
S -

4 ryanhoward@95demo.com 1 SELECT Id, MasterRecordld, Type, Parentld, BillingStreet, BillingCity, BillingState, B

4 [¥] Account
[v]1d
[IIsDeleted
[¥] MasterRecordld
[T Name
[¥] Type
[¥] Parentld
[¥] BillingStreet
[¥] BillingCity
[¥] BillingState
¥ BillingPostalCode
[¥] BillingCountry
[¥] ShippingStreet
[ ShippingCity

Or right-click an account org and generate a new query. There isa 1000 row limit based on selected fields:

¥ X g New Query W odgAai
Active ryanhoward@95democom ~ SOQL+ 2l K -

Object Explorer L S0QLOsogl”
4 pyanhoward@95demo.com 1 SELECT Id, MasterRecordId, Iype, Parentld, BillingStreet, BillingCity, BillingState, BillingPostalCode, Billil

4 [V Account i

Query 1000 Rows j
[[11sDeleted

[ MasterRecordld

[ Name

#Type

[ Parentld

[ BillingStreet

[¥! BillingCity

[+ BillingState

[¥] BillingPostalCode
[ BillingCountry

Once you have created the query, execute it by clicking the green arrow button in the task bar, or pushing F5 on your
keyboard. The results will display in a grid just below your query (ies). You'll notice that every query generated includes
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a semicolon at the end. The semicolon is a Cloudingo Studio requirement for queries that are more than one statement
long. This requirement helps our parsing engine better understand which queries you want to run individually:

HH BNewQuey @ W OA¥

i Active  ryanhoward@95democom + | SOQL= * P Run *p K E: =%

Fi

p4| Object Explorer bl

4 ryanhoward@95demo.com
4 [¥] Account

¥4

[#]1sDeleted
MasterRecordld
Name

& Type

Parentld
BillingStreet
BillingCity
BillingState
BillingPostalCade
BillingCountry
[¥] ShippingStreet
[¥ ShippingCity

[ ShippingState
[¥] ShippingPostalCode
[¥] ShippingCountry
Phone

Fax

[¥] Websits

[ Industry

[¥] AnnualRevenue
NumberOfEmployees

SOQLO.sogl*

1 SELECT Id, IsDeleted, MasterRecordld, Name, Type, ParentId, BillingStreet, BillingCity, BillingState, BillingPostalCode, BillingCountry, ShippingStreet, Shipping
ShippingPostalCode, ShippingCountry, Phone, Fax, Website, Industry, &nnualRevenue, NumberOfEmployees, Description, OwnerId, CreatedDate, CreatedByld, LastModifie
SystemModstamp, LastActivityDate, Jigsaw, JigsawCompanyId, AccountSource, SicDesc FRCM Account LIMIT 1000;

Drag a column header and drop it here to group by that column

#|1d V| IDeleted T|MasterRecordld ¥|Name  ¥|Type T|Parentld Y| BillingStrest Y| BillingCity Y| BillingState ¥ | BillingPostalCode ¥ | BillingCountry 7 | ShippingStreet
¥ 1 001G000000rS0ZBIAI  false TestName Edit From Grid!!
2 001G000000QUBLIAU false Acme Prospect 10 Main Rel. NewVork T 31349 usa 10 Main Rl

Once you have executed a new Salesforce query, you optionally export it in four different formats (Excel, CSV, HTML, or
Text) using the Export button located between the query window and grid results:

Fax

T

Industry ¥ |IsDeleted ¥ | Jigsaw Y

{212) 555-5555 Agriculture -

Media =

Excel
csv
HTML

'Sdemo.com (00:00:00.36 | 8 of 8 rows) More

Sometimes queries will be written that contain a parsing error that Salesforce cannot interpret. When that happens,
you’ll see errors displayed on the Messages tab in the grid results window as shown below. This will give you a general
idea of what the problem is:
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50QL+ v| P Run 2% 3 =%

n plelol Bl SOCL1.sogl®

| = SELECT Id, IsDeleted, MasterRecorfld, Name, Type, ParentId, BillingStreet, BillingCity, BillingState, BillingPostalCo
ShippingPostalCode, ShippingCountry, Phone, Fax, Website, Industry, AnnualBewvenue, NumberCfEmployees, Description, Ow
SystemModstamp, LasthctivityDate, Jigsaw, JigsawCompanyId, AccountScurce, SicDesc FROM Account LIMIT 1000;

3 SELECT Id, IsDeleted, MasterRecordId, RccountId, LastName, FirstWName, Salutation, Hame, OtherStreet, Otherlity, Other
MailingPostalCode, MailingCountry, Phone, Fax, MobilePhone, HomePhone, OtherPhene, RhszistantPhone, ReportasTold, Email
OwnerlId, CreatedDate, CreatedById, LastModifiedDate, LastModifiedById, SystemModstamp, LastActivityDate, LastCUReques
JigsawContactId FROM Contact LIMIT 1000;

Messages

Error running Query: INVALID_FIELD:

SELECT Id, IsDeleted, MasterRecorfld, Name, Type, Parentld
-

ERROR at Row:1:.Column:23
No such column ‘MasterRecorfld’ on entity 'Account’. If you are attempting to use a custom field, be sure to append the *__c' after the custom field name. Please reference your WS

A useful feature you will find built into Cloudingo Studio is the ability to edit org data directly from your grid results. To
edit grid data, simply double-click on a data cell in your grid and enter a new value. Once complete, simply click away
from that cell’s row and your data will be automatically saved to your org:

3 ZELECT Id, IsDeleted, MasterRecordId, Zccountld, LastName, FirstWame, Salutation, Name, OtherStreet,
MailingPastalCode, MailingCountry, Phone, Fax, MobhilePhone, HomePhone, OtherPhone, AssistantPhone, Re
OwnerlId, CreatedDate, CreatedById, LastModifiedDate, LastModifiedById, SvstemModstamp, LastActivityDa
JigsawContactId FROM Contact LIMIT 1000;

Id T |IsDeleted ¥ | MasterRecordld T | Name T|Type T |Parentld T | BillingStreet
1 001G000000rS0ZEIAL  false TestName Edit From Grid!!
2 001G000000quBbIIAU  false Acme Prospect 10 Main Rd. New e
3 001G000000quBbKIAU false salesforce.com Customer The Landmark @ Cne Market, Suite 300 San Fre
4 001G000000quBbLIAU false Global Media  Prospect 150 Chestnut Street Toront
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SOQL+ (ADVANCED FEATURES)

Cloudingo Studio has been outfitted with a new extension of Salesforce’s SOQL query language, named SOQL+. With
SOQL+, the team at Symphonic Source added slick new enhancementsto enable faster and more powerful queries
against your Salesforce Org. Just ensure your query language setting is set to SOQL+ in the language selector, and
you’re good to go:

¥ E P NewQuey @ W OA X
: Active ryan.howard@95demo.com = SOQL+

j3l Object Explorer S0QL+
* 4 ryanhoward@95demo.com soqQL

b [¥] Account

» [7] AccountContactRole
» [l AccountFeed

» [T] AccountHistory

» [T AccountShare

» [l ActivityHistory

» [] AdditionalNumber
» [[] AggregateResult

» []ApexClass

» [T] ApexComponent
» [[Apexicg

» [l ApexPage

L Tk [

Some of the SOQL+ featuresinclude:

ENHANCED INTELLISENSE

Whether you're creating a unique SOQL+ query or just a basic select, Intellisense will assist you in creating the query
faster than ever by displaying the available objectsto query from and the functions you can perform on them:

1 SELECT * FROM
% Account » | IzesD
™ AccountContactRole :
" AccountFeed
% AccountHistory
% AccountPartner
% AccountShare
P KeivityHistory
% AdditicnalNumber
% AggregateResult
S ApexClass -
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SELECT ALL QUERIES

By typing in “SELECT * FROM Account”, or “SELECT * FROM” any org, you can automatically pull back all the fields
associated with that org without having to type them all out one-by-one!

INSERT, UPDATE, AND DELETE STATEM ENTS

We’ve created a sweet translation engine that allows you to run SQL type queriesin the Cloudingo Studio editor.
Cloudingo Studio converts them into API calls so whether you just want to do a quick update or clear out records by a
specific field type, Cloudingo Studio has you covered. Here are a few examples:

Use an UPDATE statement to change the name field on an account in your org. Update statements should, when
referencing fields, surround the values with single quotes as shown below:

UPDATE Account SET Name = 'Updated Names' WHERE Id ='001G000000r50nhIAA’;

A standard INSERT statement follows the same general rule when referencing field values. The breakdown for an insert
statement is shown with an example below:

INSERT INTO Account (Name) VALUES ('New Account Field');

Below is a standard DELETE statement where Cloudingo Studio removes one of the account records from the
connected org. Field references using single quotes still apply:
DELETE FROM Account WHERE Name = 'New Account Field';

LOOPING, AND VARIABLES:

Along with SOQL+, we've also added in some custom looping, and variable functionality. You can now create custom
variables, assign variablesto other variables (Scope is also taken into consideration. A variable created within a ‘while’
loop has higher priority than one created in the general query statement), and increment/decrement variables using
the ‘+=’ or *-=" statements:

The following example will create a new grid query result on each loop iteration, and will continue to loop while varl
islessthan var2, and isincremented on each loop by adding the value of var3 to var1:

var varl = 1;
var var2 = 10;
var var3 = 1;

while(varl < var2)

{
SELECT * FROM Account LIMIT 1000;

varl += var3;

}

‘while’ loops can have up to 6 different types of value comparisons:

Note equal: !=
Greater than or equal to: >=
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Less than or equal to: <=
Equal to: =

Greater than: >

Less than: <

All changes using SOQL+ statements will show resultsin the “Messages” tab on the results pane:

SO0QL+ = p Run 9 % 3= =%

1]
- SOQLO.soql* gEelell BT iy
1 UPDATE Account SET Name = 'Updated Name' WHERE Hame = 'TestName';

Messages

Update Successful: UPDATE Account SET Name = 'Updated Mame” WHERE Name = 'TestName'
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ROW COUNT USING SELECT COUNT

We've also created a way to get the number of rows on a specified org by simply typing “SELECT COUNT() FROM
SomeOrg;”. After executing that query you’ll see the resultsin the Messages area on the results pane:

SOQL= | p Run *p % = =%

- I:‘I
SOQLO.soql* EEel8RET | i

1| SELECT COUNT() FROM Account;

Messaqges

4 rows found

SAVING/ OPENING SOQL QUERY FILES (ADVANCED USE)

Cloudingo Studio provides you a way to save and open previous SOQL/SOQL+ files directly to your file system. Once
ready to save a new query, simply go to the File menu, and click Save:

File| Edit View Options Window Help

*¥  Connect to Salesforce dax
X Disconnect from Salesforce m + SO0l - P o=

- s

SELECT COUNT() FROM Account:

B

Open
Open Recent
Close

Close All

Save As
Save All

“EE EE
H

Exit
|| ApexClass

» [Tl ApexComponent
» [ClAperiog

b [T ApexPage

» [ ApexTestQueueltem
»

[ ApexTestResult
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A save dialog popup will appear allowing you to specify the file. Once saved, the tab will be renamed and the asterisk
will disappear:

File Edit View Options Window Help
M XE HNewQuey Wl AN

i Active ryan.howard@95demo.com ~ SOQL+ Bk -

- Object Explorer MR | | NewsavedQuerysoql

— | 4 ryan.howard@95demo.com 5 1 SELECT COUNT() FROM Account;
» [ Account

» [} AccountContactRole
» []AccountFeed

» [T] AccountHistory

» [C]AccountPartner

» [ ]AccountShare

» [T] ActivityHistory

» [T]AdditionalNumber
» []AggregateResult

» [T]ApexClass

» [] ApexComponent

To open a SOQL/SOQL+ file you have previously saved, simply go back to the File menu, and select “Open”:

File| Edit View Options Window Help

*¥  Connect to Salesforce (3] [ 4
X? Disconnect from Salesforce m ~ SOQL+ - 0K I ==

i -
@ Open

Open Recent ’
# Close

Exit
» || ApexClass
» (] ApexComponent

An open file dialog will appear. Simply navigate to the file you want to open, select it, and click the Open button on the
dialog box. The saved query will open in a new tab.
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TROUBLESHOOTING
GETTING CLOUDINGO STUDIO’S VERSION NUM BER:

Sometimes you’ll need to obtain the current version number of your copy of Cloudingo Studio. To do this, simply go to
the Help menu, and select About. A popup box will appear displaying the version of Cloudingo Studio.

demo.com ~ SOQL+ ' T

*mo.com NT() FROM Acc
Feature Request

Support Request
tactRole

3 About...
ory
ner

re

iy

LOCATING CLOUDINGO STUDIO ERROR LOG

By default, Cloudingo Studio writes an error log in its working directory. To access this log, do the following:

1) Start-up Cloudingo Studio.

2) Right-click on your windows task bar and select Start Task M anager, select the Applications tab, and find
Cloudingo Studio in the list of running applications.

3) Right-click on Cloudingo Studio in the list of applications, and select Go to Process.

4) Inthelist of processesyou’ll see the Cloudingo Studio process. Right-click that process and select Open file
location.

5) The location of the running application will pop-open. Inside that folder you’ll find the Cloudingo Studio log,
labeled “CloudingoStudio.log”.
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Shortcut keys

Connect to Salesforce
Disconnect from Salesforce
Open Query

Save Query

Copy

Paste

Cut

Execute Query

CTRL +i
CTRL +d
CTRL + 0
CTRL +s
CTRL +c
CTRL +v
CTRL +x

F5
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